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SECTION A: Guidelines for the creation of the ETS project

Rules to follow for the ETS project 
Here is a brief list of basic rules that should be followed during the realisation of the project (with KNX ETS3) of an automation system to be managed by 
the Well-Contact Suite Software, so that the import or re-import of the files exported by ETS3 require the least possible additional work to configure the 
WellContact Suite software:

1. All the premises (rooms) must have different names.

2. The parts of the building (floors, areas,…) must have different names from the premises (rooms).

3. To be recognized as such (rooms) by the SW, the premises must include at least one device (otherwise they will be recognized as areas).

4. Different parts of the building (floors, areas,…) must not have similar names within the same building.

5. During the creation of the group addresses you must not use the same names for main groups and middle groups.

6. You must create a different group address for each property you intend to use for each device.

7. List of the addresses that must be created for the Well-Contact Suite software to provide all the expected features:

a.	 Transit for readers and pockets (PropID 0):  important and necessary to the WCS System for the recording of access and stay in the room;

b.	 Time for readers and pockets (PropID 18): essential for the management of the access control and the possible management using time frames;

c.	 Date for readers and pockets (PropID 19): essential for the management of the access control;

d.	 ServerConfirm for readers and pockets (PropID 20): to confirm the reception of the transit telegrams via the SW and remove them from the inter-
nal memory of the devices;

e.	 PlantID for readers and pockets (PropID 21): essential for the management of the access control;

f.	 AccessData for readers and pockets (PropID 22) : essential to allow access to the cards created with the SW;

g.	 AccessType1, AccessType2, AccessType3, AccessType4, AccessType5, AccessType6, AccessType7 for the pockets (PropID 2, 3, 4, 5, 6, 7, 8) : 
useful for viewing the presence of customers and staff inside the room from the SW;

h. 	 DoNotDisturb (LedOn1 (PropID 30)) for the reader: useful for viewing that customers do not want to be disturbed from the SW; in order for this 
address to have this function, the Address/Subject "Do Not Disturb" must be assigned to it through the ETS Configuration of WCS.

i. 	 Actual Temperature for the thermostats (PropID 0) : useful for viewing the temperature of the thermostats from the SW (it is advisable to set the 
cyclical sending in the parameters. To be considered in case of a high number of devices);

j. 	 Thermostat Mode or alternatively Comfort, Standby, Economy, Protection for the thermostats (PropID 5 or 1, 2, 3, 4) : important to send 
commands about the Mode of Operation of the thermostats via WCS;

k.	 Thermostat Mode State for the thermostats (PropID 6): important for viewing the current Mode of Operation of the thermostats from the SW;

l.	 State Summer/Winter (PropID 7): important for viewing the current Seasonal Mode of Operation of the thermostats from the SW;

m.	 Enable Summer/Winter (PropID8): essential for sending the commands about the Seasonal Mode of Operation of the thermostats via the WCS 
System;

n.	 Actual Temperature for the thermostats (PropID12 0) : useful for viewing the temperature of the thermostats from the SW (it is advisable to set the 
cyclical sending in the parameters. To be considered in case of a high number of devices);

o. 	 Comfort Winter-Setpoint, Standby Winter-Setpoint, Economy Winter-Setpoint, Protection Winter-Setpoint, Comfort Summer-Setpoint, 
Standby Summer-Setpoint, Economy Summer-Setpoint, Protection Summer-Setpoint for the thermostats (PropID 14, 15, 16, 17, 18, 19, 20, 
21): useful for viewing and setting various "basic setpoints" for the two Seasonal Modes of Operation from the SW.

	 NOTE: to view the values ​​you must manually set the reading flag for these properties in ETS3.

p.	 Heating/Air Conditioning Speed management statistics for the thermostats:

• Proportional Management:
- Proportional (0 - 100%) - Fan Input (PropID 25): useful for sending the value of the maximum proportional speed.
- Proportional (0 - 100%) - Fan Output (PropID 31): useful for viewing the value of the maximum proportional speed from the SW.

• On/Off Management:

- �Off– Fan Input, Speed V1– Fan Input, Speed V2– Fan Input, Speed V3– Fan Input, Automatic – Fan Input (PropID 26, 27, 28, 29, 30): use-
ful for sending commands to override the speed or force the automatic management of the thermostat.

- Speed V1– Fan Output, Speed V2– Fan Output, Speed V3 – Fan Output (PropID 32, 33, 34): useful for viewing the current active speed.

- �Speed V1– Fan Disable, Speed V2– Fan Disable, Speed V3 – Fan Disable (PropID 35, 36, 37): useful for sending commands to disable the speed.

q. Windows Open for the thermostats  (PropID 38, 39): to view the window status from the Software, you must:

1. Set the contact as General Purpose and use it as an open window sensor

2. Assign the created group address  to the Window Switch property (PropID 38) as well as to a Konnex module input (if you use the thermostat 
input, assign the address to the thermostat's  propID 39).
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3. Assign the Address/Subject "Contact" to such address in the Well-Contact Suite software.

NOTE: window Contact: WCS displays the design of the open window closed in a environment based on the presence (defined in configuration ETS) 
in the same environment of group addresses defined as "Contact". Upon import, are recognized as "Contact" the addresses with an "S" (send)  flag 
connected to the property 38 of the thermostats (Windows Switch). If different addresses in the same environment are automatically or manually defined 
as "Contact" it'll be enough for just one of them to take the value "1" and the WCS will show the drawing of a open window. Otherwise the window 
will be closed. The property Windows Switch, however, is a property with a Write, not Read, flag. If, as usual, the contact on the thermostat is used as 
a window contact, the input of the thermostat will be set up as "General Purpose", "Status Send", "FallingEdge On" and "RisingEdge Off." The same 
group address must be placed on the property 39 "Input" and on the property 38 "Window Switch". If you left the specific "Input" configuration as 
"Window Switch", the thermostat would behave correctly (Protection status with open contact, "normal" status with closed contact), but no information 
would be sent on the bus, so the software could not understand if the window is open or closed.

r. 	 Temperature: Automatic/Manual for the thermostats (PropID 45): useful for viewing if the setpoint was set through the SW or manually using the 
keypad.

s.	 Fancoil: Automatic/Manual for the thermostats (PropID 46): useful for viewing if the current fancoil speed is automatically controlled by the thermostat 
or has been forced.

t.	 Temperature: disable local operation for the thermostats (PropID 47): useful for viewing and sending commands about the chance to set the 
current setpoint using the keypad from the SW.

u.	 Fancoil: disable local operation (PropID 48): useful for viewing and sending commands about the chance to force the speed using the keypad 
from the SW.

v.	 CardInserted for the holder (PropID 40): it is necessary for the suite management.

	 IMPORTANT: CardInserted MUST NOT be read at the start of the software.

8.	 The address to a Comfort Mode, Economy Mode, etc. bit are not used by the software, but are needed to manage status changes of the thermostat 
with bus logic (For example the Guest Access telegram sent by the pocket can be used to set the thermostat as comfort when the client enters the 
room and to put the thermostat in standby when he gets out).

9.	 Control value must NOT be used

10. "Double" thermostat configuration (Article Code. 14430 Plana, 16915 Idea; 20430 Eikon)
	 The configuration of a double thermostat is substantially identical to that of a single thermostat. For proper display and use by WCS, the same addresses 

need to be configured (see above), doubled if you also want to use the "B" section of the thermostat.
	 You can set specific addresses to know the temperatures detected by the 2 sensors (internal and external probe) that will determine the current 

temperatures of the 2 thermostats on the basis of weight factors. Such addresses are not displayed in the software unless manually defined by the user 
in the supervision.

	 When importing ETS, the software considers the thermostat "B" as in use if it detects that properties11 (Actual Temperature), 62 (EnableSummer / Winter) 
and 66 (ActualSetpoint) have been configured with an address group.

	 The display of the window switch, follows the same specifications provided above. Obviously, the physical contact on the device is only one (property 101 
"Input"), while the properties "Window Switch" are 2, one for each thermostat. By configuring the three properties with the same group address, at the 
opening of the contact, both thermostats will go in protection mode and the software will display the open window. Of course you can also use 2 different 
addresses to drive the 2 "Window Switches" that are transmitted on the bus by any module with digital inputs.

	 In "WCS - ETS Configuration" the double thermostat is seen as a single device. As the single device, it may be associated with Functions and Zone Mas-
ters, then deciding whether only "A", only "B" or "A+B" should be managed.

	 In "WCS - Supervision" the double thermostat is seen as if therewere 2 devices  to all intents and purposes; you can then hide/remove a thermostat (A or 
B, if enabled) as if it were a single thermostat, rather than add one to other supervisions of other rooms (as you would for a single thermostat).

	 By convention, the first thermostat is indicated in supervision by the letter "A", the second with the letter "B".

11. When creating the ETS system topology (Building view) you must create a new building (“Add Building”), add parts of the building (the floors) and then 
add the premises (the rooms). All elements represented by the hammer icon (in ETS “functions”) cannot be imported via ETS, because the XML files are 
not created properly filling out the “Local” value.

12. External transponder touch reader configuration (Art. Code 21457 “Eikon Evo”)

The configuration of the external transponder touch reader is essentially identical to the one of the transponder reader.

In addition to the configuration objects described in Section 7, we recommend that you also configure the following communication objects:

Object 67 Ring Touch: it is the object that must be configured for the “bell” feature of the device.

Object 72 Remove Plate: Necessary for the WCS System to pick up the “plate Removal” alarm, in the case when the plate is removed from the device. 

13. Optimisation for creating staff cards (staff)
	 Access to a room involves enabling the card on all the transponder readers that control access to the room (by sending a message to each reader, to the 

address associated with the communication object 22 AccessData). 
The enabling procedure can be speeded up by creating also group addresses common to multiple readers associated with the communication object 22.
The Well-Contact Suite software is able to determine whether common group addresses have been set up to enable access and it optimizes the card 
enabling procedure, minimizing the number of messages to be sent. 
E.g.: Suppose that, in addition to the necessary different group addresses, for each transponder reader (associated with the communication object 22), 
you also want to create a common group address for all the readers of the rooms of a hotel to associate with all the communication objects 22 of the 
room readers.
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When creating a personal card that needs to have access to all the hotel rooms, the Well-Contact Suite software detects that a common address 
has been configured for the reader communication object 22 and it sends a single message instead of sending as many messages as there are room 
transponder readers.
The effect of this optimisation is clear as the number of rooms increases.
In addition to a common address for all the readers, other addresses can also be created, common for example to the readers of the different floors or to 
partitions of the system reader set. 
The Well-Contact suite software will always look for the minimum number of messages to send.

14. Plate removal alarm of the devices  KNX 4-button switch (Code 21840) and KNX 6-button switch (Code 21860): you must configure the communication 
object 18 for the Well-Contact Suite software to be able to handle the plate removal alarm. If the communication object 18 is configured, the Well-Contact 
Suite automatically creates the management item for the notification of this alarm.

15. 8-channel DALI KNX gateway (Code 01544) channel configuration. 
For the correct management of the graphical object “dimmer” of the Well-Contact Suite software, you must configure the following communication objects 
for each channel you want to manage (the PropID numbers refer to channel A):

- PropID 0 On / Off: ON/OFF command of the dimmer

- PropID 2 Set Brightness Value : configuration of the percentage of brightness of the dimmer

- PropID 5 Telegr. Status On / Off: reading of the activation status of the dimmer

- PropID 6 Telegr. Status Brightness Value: reading of the percentage of brightness of the dimmer

16. Actuator for 8 rolling shutters KNX (Code 01525) configuration
Control without slat adjustment.

In the ETS parameters configuration, for each output to be managed with the Well-Contact Suite software, the following is required:

- In the “General” window, set  “Operation mode” on “Control without slat adjustment”;

- In the “Drive” window, set the parameters related to the duration of the movement of the curtain;

- In the “Functions” window, enable “Enable positions/presets”

- In the “Positions/Presets” window, enable “Move to pos. height/Move slat 0…255”

For the correct management of the graphical object “blinds” of the Well-Contact Suite software, you must configure the following communication objects 
for each output you want to manage (the PropID numbers refer to output A):

- PropID 10 Move blinds/shutters up-down: up / down command of the curtain

- PropID 11 Slat adjustm./stop up-down: command stopping the movement of the curtain

- PropID 13 Move to position height 0..255: command to set the percentage of the position of the curtain

- PropID 33 Status height 0…255: reading of the percentage value of the position of the curtain

Control with slat adjustment.

In the ETS parameters configuration, for each output to be managed with the Well-Contact Suite software, the following is required:

- In the “General” window, set “Operation mode” a “Control with slat adjustment”;

- In the “Drive” window, set the parameters related to the duration of the movement of the curtain;

- In the “Blinds/Shutters” window, set the parameters related to slat adjustment;

- In the “Functions” window, enable “Enable positions/presets”

- In the “Positions/Presets” window, enable “ Move to pos. height/Move slat 0…255.

For the correct management of the graphical object “blinds” of the Well-Contact Suite software, you must configure the following communication objects 
for each output you want to manage (the PropID numbers refer to output A):

- PropID 10 Move blinds/shutters up-down: up/down command of the curtain

- PropID 11 Slat adjustm./stop up-down: command stopping the movement of the curtain

- PropID 13 Move to position height 0..255: command to set the percentage of the position of the curtain

- PropID 14 Move slats 0..255: command to set the percentage of rotation of the slats

- PropID 33 Status height 0…255: reading of the percentage value of the position of the curtain

- PropID 34 Status slat 0…255: reading of the percentage value of the rotation of the slats

17. Optimization for creating personal cards

Access to a room involves enabling the card on all the transponder readers that control access to the room (by sending a message to each reader, to the 
address associated with the communication object 22 AccessData). 
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The enabling procedure can be speeded up by creating also group addresses common to multiple readers associated with the communication object 22.

The Well-Contact Suite software is able to determine whether common group addresses have been set up to enable access and it optimizes the card 
enabling procedure, minimizing the number of messages to be sent. 

E.g. Suppose that, in addition to the necessary different group addresses, for each transponder reader (associated with the communication object 
22), you also want to create a common group address for all the readers of the rooms of a hotel to associate with all the communication objects 22 
of the room readers.

When creating a personal card that needs to have access to all the hotel rooms, the Well-Contact Suite software detects that a common address 
has been configured for the reader communication object 22 and it sends a single message instead of sending as many messages as there are room 
transponder readers.

The effect of this optimization is clear as the number of rooms increases.

It is also possible, in addition to a common address for all the readers, to create other addresses, common for example to the readers of the different floors 
or to partitions of the system reader set. 

The Well-Contact suite software will always look for the minimum number of messages to send.
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Parameters to set on the transponder readers 

Key A  

On both types of the transponder readers (external transponder reader and pocket transponder reader) you must set the "Key A" from the "CardInfo" win-
dow of these devices' parameters, using the KNX ETS3 software. 

The highlighted values ​​can be at will  using the same values, and shall then be reported in the following window of the WCS SW:
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The procedure to import the system data from the Well Contact software involves the use of four files that describe the system itself, which must be first 
created through the ETS3 exporting procedures and which are listed below: 
• file System structure (XML file type)
• file Devices (XML file type)
• file Device configuration (XML file type)
• file ESF (ESF file type) 

The four above-mentioned files contain information about the topology of the system, the devices installed, the group addresses assigned to the various 
devices and the list of all the defined addresses. 
The following sections describe the four files and how to create them through ETS3. 

The file System structure

Introduction

The file "System structure" contains information about the structure of the Konnex system, in terms of: buildings, floors, rooms or electric panels.  This sec-
tion is not bound in any way by the ETS3 software, which allows the designers to organize the devices as they see fit. 
Following a certain logic in the definition of this "tree" (see for example the ETS project made available) you can configure the Software for Well-Contact 
almost entirely automatically, as regards the definition of the floors and rooms or common areas of the hotel. 
Organizing the devices in a timely manner right from the programming of the ETS will reduce the effort to configure the Software for Well-Contact. The files 
"System structure" and "Devices" are logically related; the first, stops at the definition of the system structure, while the second, "continues" defining which 
devices each "terminal node" of the system structure contains.
Below is the description of the sequence of the operations to perform using the ETS3 software to correctly export the above-mentioned file. 

Creating the file System structure 

To create this file, proceed as follows: 

1. �Select all buildings, floors and rooms from the window  "Buildings" of ETS3. Then select any row in the "Parent/Name" top section.

SECTION B: Exporting the system configuration files from ETS3 
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2. From the File menu, select " Extract Data (e.g. OPC)". 
The window  Export Foreign Format shall appear.

3. From the Export Foreign Format window, select the "Export…" button from the "Export to CSV/XML" section

4. �From the Export List Content  window select "All" from the "List items" section, select "XML" from the "Export Format " section and press "OK"

5. From the window that appears:
a. select the destination folder for the file System structure
b. type the name of the file: System structure
c. press the button SAVE.  

NOTE: The file extension shall be XML.
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The file Devices

Introduction

The file "Devices" includes, for each device in the system, the following information:

• Physical address

• Name of the node containing the device in the tree structure of the system (derived from the file "System structure".

• Description assigned by the ETS designer (who designed the ETS system)

• Application software loaded to the device, which identifies the functions it will be able to perform.

Creating the file Devices

To create this file, proceed as follows: 

1. �Select all buildings, floors and rooms from the  “Buildings” window of ETS. Then select any row from the “Parent/Address/Room…” section at the bot-
tom.

2. From the File menu, select “Extract Data (e.g. OPC)”. 
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The window Export Foreign Format shall appear.

3. From the Export Foreign Format window, select the "Export…" button from the "Export to CSV/XML" section

 

4. �From the  Export List Content window select ”All” from the  “List items” section, select “XML” from the “Export Format” section and press “OK”

5. From the window that appears:

a. select the destination folder for the file Devices

b. type the name of the file: Devices

c. press the button  SAVE.

NOTE: The file extension shall be XML.
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The file Device configuration

Introduction

The file "Device Configuration" contains the list of the group addresses assigned by the ETS designer to each property of each device, uniquely identified by 
the physical programming address.

Creating the file Device configuration

To create this file, proceed as follows: 

1. Select all the devices from the "Topology"window. Then select any row from the section on the right.

2. From the File menu, select “Extract Data (e.g. OPC)”. 
The window Export Foreign Format shall appear.

3. From the Export Foreign Format  window select the “Export…” button from the “Export to CSV/XML” section
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4. �From the  Export List Content window select ”All” from the  “List items” section, select “XML” from the “Export Format” section and press “OK”

5. From the window that appears:

a. select the destination folder for the file Device configuration

b. type the name of the file: Device configuration

c. press the button  SAVE.

NOTE: The file extension shall be XML.
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The file ESF

Introduction

In addition to the XML files described above (System structure, Devices, Device Configuration), you must export an ESF file, which includes a list of all the 
defined addresses (assigned to at least one device) in the ETS project. 

All the addresses would still be recognizable after importing the XML files.  

Their organization as a tree structure can also be derived from the three levels of which the addresses themselves are composed.  The additional informa-
tion that the ESF file contains is the name given to the nodes that make up the maingroups and middlegroups. 

The organization of the group addresses, as defined in the ETS's "Group Addresses" view, is not bound in any way.  It's up to the ETS designer to organize 
the addresses so that they're easier to use from the Software for Well-Contact. 

A good example of organization of the group addresses is shown in the picture below: 
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Creating the file ESF

To create this file, proceed as follows: 

1. From the File menu, select “Extract Data (e.g. OPC)”. 
The window Export Foreign Format shall appear.

2. From the Export Foreign Format  window select the “Export…” button from the “Export to OPC Server” section

 

3. From the window that appears:

a. select the destination folder for the file

b. type the file name (the choice of the name is not bound in any way and its extension shall be ESF in any case).  

c. press the button  SAVE.
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SECTION C: Simultaneous use of the Well-Contact Suite and other software that 
use the KNX Falcon libraries  SECTION B: Exporting the system configuration files 
from ETS  
Introduction

The Well-Contact Suite software uses the KNX Falcon libraries to access the bus. 
The default configuration of such libraries may not allow the use of the Well-Contact Suite together with other software applications that use the same librar-
ies (e.g. KNX ETS). 
When it's impossible to use the Well-Contact Suite software together with other programs that use the KNX Falcon libraries to access the KNX bus, follow 
the procedure below to solve the problem. 

Procedure to allow the simultaneous use of the Falcon libraries to the Well-Contact Suite software and others that 
use them

To solve the problem of the simultaneous use of the Falcon libraries by the Well-Contact Suite software and other applications, follow these steps: 

1. �Verify that the Well-Contact Suite software and ETS3 (or any other software that uses the KNX Falcon  libraries) are closed (inactive). If not, close them. 

2. Open the Control Panel: Start -> Control Panel.

3. Access the "Administrative Tools" section: double click Administrative Tools.

SECTION C: Simultaneous use of the Well-Contact Suite and other software 
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4. Access the "Component Services" section: double click Component Services.
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5. From the tree structure on the left access the following path:  
Component Services -> Computers -> My Computer -> DCOM Config 
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6. �On the right, locate Falcon. Right click the Falcon icon and select Properties. 
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The following window appears. 

 

7. Select the Identity tab.  
Select "Interactive User" and press "OK", as shown in the picture below.

8. Close the Component Services window.
9. Close the Administrative Tools window.
10. Restart the computer 
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How to solve a problem that may occur when using the "interactive user" to access the Konnex Falcon libraries.

In some cases (on some computers that were tested) the procedure described in the previous chapter (Procedure to allow the simultaneous use of the Fal-
con libraries to the Well-Contact Suite software and others that use them was not sufficient to allow the connection to the Konnex bus. On such computers 
it was necessary to do more to allow the proper connection to the Konnex bus (from multiple applications that use the Konnex Falcon libraries). 

Such procedure is described below. 

Introduction

The account to access the Windows session (Windows account) must include a password and must be the same account used to start the 
Well-Contact Suite software 

Procedure 

Proceed as follows: 
1. Open  Control Panel -> Administrative Tools -> Services
2. Select "BIG Falcon Gateway" from the list on the right 
3. Right click and select Properties
4. Access the "Connection" tab
5. �Select "Account" and enter username and password (and confirm the password) for the account used to access the Windows session (Windows user) 

in order to use the Well-Contact Suite software
6. Press “OK”.
7. Close the Services window
8. Restart the PC
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Client/Server Connection using the public network 

Introduction

To run a client/server connection via public network you must know the public IP of the router/firewall (or point to it via DNS) connected to the Well-Contact 
Suite Software Server. Since this is a rather delicate operation, please contact the Vimar Technical Assistance.

Actions to be performed on the PC where the WCS “Server” is installed:

Open the SQL Server Configuration Manager program ( Windows Menu-> Programs -> Microsoft SQL Server 2008 -> Configuration Tools -> SQL Server 
Configuration Manager); in SQL Server Configuration Manager select SQL Server 2008 Network Configuration, and then Protocols for SQLVIMARWCS; 
doubleclick TCP/IP and navigate the IP Addresses menu. In this menu delete the zero from all the TCP dynamic ports rows (also from IPAll) and set up a free 
port on IPALL: TCP Port (recommended port 1435, check that the port is free on the PC used). Click Ok.

If SQLBIGSTUDIO is not there, do the following:

Launch the registry key menu. 
-	If installing on Windows 32-bit, perform the following steps: 
	 Windows menu > Run > Regedit > HKEY_LOCAL_MACHINE > SOFTWARE > BIG > BIGSTUDIO2 > BIGGateways > DBConnectionstring > Modify; 

-	If installing on Windows 64-bit, perform the following steps:  
	 Windows menu > Run > Regedit > HKEY_LOCAL_MACHINE > SOFTWARE > WOW6432Node > BIG > BIGSTUDIO2 > BIGGateways > DBConnection-

string > Modify. 

ONLY change the string “Data Source”: delete the data written after “=” and replace it with the IP address of the machine and the port used; in our example: 1435.

So, still in our example, the last part of the connection string would look like this: Data Source=ip of the server, 1435. Reboot the PC.

Otherwise, choose Protocols for SQLBIGSTUDIO; double click TCP/IP and navigate to the menu “IP Addresses”.
In this menu, delete the value zero from all TCP dynamic ports rows (also for IPAll) and set up a free port on IPALL:TCP Port (recommended port: 1436, check 
that the port is free on the PC used). Click Ok.

Launch the registry key menu. 
-	If installing on Windows 32-bit, perform the following steps: Windows menu > Run > Regedit > HKEY_LOCAL_MACHINE > SOFTWARE > BIG > BIG-

STUDIO2 > BIGGateways > DBConnectionstring > Modify; 

-	If installing on Windows 64-bit, perform the following steps:  Windows menu > Run > Regedit > HKEY_LOCAL_MACHINE > SOFTWARE > WOW6432Node 
> BIG > BIGSTUDIO2 > BIGGateways > DBConnectionstring > Modify. 

ONLY change the string “Data Source”: delete the data written after “=” and replace it with the IP address of the machine and the port used; in our example: 1436.

So, still in our example, the last part of the connection string would look like this: Data Source=<ip of the server>, 1436. Reboot the PC.

Actions to be performed on the PC where the WCS “Client” is installed: 

Launch the registry key menu: 
-	If installing on Windows 32-bit, perform the following steps: Windows menu > Run > Regedit > HKEY_LOCAL_MACHINE > SOFTWARE > Vimar > WCS 

> DBConnectionstring > Modify

-	If installing on Windows 64-bit, perform the following steps: Windows menu > Run > Regedit > HKEY_LOCAL_MACHINE > SOFTWARE > WOW6432Node 
> Vimar > WCS > DBConnectionstring > Modify. 

ONLY change the string “Data Source”: delete the part of the string “\SQLVIMARWCS” and replace it with the port used (in our example: 1435).

So, still in our example, the last part of the connection string would look like this: Data Source=<ip of the server>, 1435. Reboot the PC.

IMPORTANT NOTE: You need to create access rules on the router/firewall connected to the server for the port of the Master Gateway (4321) and access to 
Database (in our case, 1435 and 1436) and, if enabled, create rules on Windows Firewall.
It is also recommended to enable the encryption of the master gateway, following the steps listed in the installation and configuration manual (Chapter 
SERVER WCS)

Writing the cards from the Client to the card programmer connected to the Server

If you want to write the cards on the card programmer connected to the Server from the WCS client, you need to change the IP address of the card program-
mer in the Client settings (menu Configuration -> General Settings Configuration -> Programmer Gateway), entering the public IP of the router/firewall (or the 
DNS pointing to it) that is connected to the Server.  Furthermore, you must create an access rule on the router/firewall connected to the server to the port on 
the card programmer (8001), and, if enabled, create the rule on Windows Firewall.

NOTE: It is recommended to enable the encryption of the programmer gateway, following the steps listed in the installation and configuration manual (Chapter 
PROGRAMMER GATEWAY).

SECTION D: Using the Well-Contact Software Suite software through the public network  
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NOTES

SQL SERVER 2005 UPDATE

Windows Update could update (patch) the software SQL Server 2005. During this update, you should close the WCS (by logging out), or the program won’t 
function correctly. After the update is completed, you can return to using the WCS properly.

OPERATING SYSTEM SUSPENSION 

If the operating system is suspended (manually using the command “Sleep” or automatically for energy-saving policies) and then the session is restored, the 
Falcon KNX will not work properly. To go back to use the Well-Contact Suite software correctly, you’ll need a reboot.

NO CONNECTION TO THE BUS BY THE WELL-CONTACT SUITE SOFTWARE INSTALLED ON WINDOWS XP

If you experience problems connecting the Well-Contact Suite software installed on Windows XP to the bus, we recommend uninstalling the 
Falcon 2.0 libraries and installing the Falcon 1.8 libraries. Before you do this, contact the Vimar technical assistance.
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